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Seamless and secure, online proctoring.



Step 1: Sign in to Examity

Step 2: Schedule Exam

Step 3: Connect to Proctor

Step 4: System Check

Step 5: Install Examity Extension and Grant Permissions
Step 6: Authentication

Step 7: Review Instructions

Step 8: User Agreement

Step 9: Screen Launch
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Live Proctoring Exam Overview

Install Examity
System Check |~ | Extensionand | | Authentication
Grant Permissions

Connect to
Proctor

Sign in to

Examity Schedule Exam

Review - . User
Instructions Agreement

End Proctoring .- Survey
Session (Optional)




Live Proctoring Exam Overview
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Welcome to Examity

Examity® is the global leader in online proctoring.

. . Username
Our end-to-end solution includes authentication, R

live monitoring, recording, and auditing.

S | gn | n to Exa m |ty Test takers enjoy a seamless experience Password
anytime, anywhere with lots of flexibility.
O 1 Forgot your password?
Need Help?
B3 Live Chat
¥ Support Phone Numbers LOGIN
% support@examity.com
REGISTER
Examity & Privacy Policy

The test-taker will need to sign in to Examity, if they have not already done so, using
the link provided in the welcome email: https://on.examity.com/V5/x/217



https://on.examity.com/V5/x/217
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*Pearson - IT - New_7th sp Vv

Schedule appointment

*Pearson - IT - New_7th sp — Instructor: Examity Live

May 2022 ® 11:00 AM

ACCUPLACER

Tu  We Fr @ 11:30 AM
@ Exam not scheduled 17 ° 4 6 ® 12:00 PM

Exam Window May 1, 2022 12:14 PM to Jul 0 1 13 12:30 PM
21, 2022 6:59 PM

Schedule Exam B i W

@ Exam Duration 9 hours 1:30 PM
24 25 26 27

2:00 PM
s= View Exam Rules 5 30 31 1 2 3 4

® Exams scheduled within 24 hours may incur an
Schedule Exam additional fee

Appointment selected for May 3, 2022 12:00 PM Central Daylight Time, if you
would like to reserve this time click Schedule Appointment.

2:30 PM

Ea0e 6

Once logged in, the test-taker will see their exam card on their dashboard. The
test-taker needs to schedule their exam by clicking Schedule Exam. A pop-up
window will appear, and the test-taker must select their desired date and time
and then scroll down and click Schedule Appointment.
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Schedule Exam

Pay for Exam
(If Applicable)

Schedule appointment

May 3, 2022 12:00 PM CT

[ Exam: ACCUPLACER

(10 course: *Pearson - IT - New_7th sp

Exam Window: May 1, 2022 12:14 PM CT to Jul 21, 2022 6:59 PM CT

¢ Exam Duration: 9 hours

Exam Fees

Proctoring Fee $1.00

You will be redirected to the payment system to pay any amount due before
scheduling.

Amount Due: $25.00

If the course is setup for test-taker pay, then before finalizing the appointment, the

test-taker will be prompted with payment before finalizing. The test-taker can click
Pay Now to continue the payment process.
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Schedule Exam

Pay for Exam
(If Applicable)

Process Payment

State * ’ Texas

Country USA (change)
ZiplPostal Code * |

Phone * ’

(J Define invoice details (if different than the cardholder)

(0 Securely store card details for recurring payments or future transactions

TrustedSite

SECURE CHECKOUT

The test-taker will need to enter their payment and billing information and
then click Submit.




V
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Schedule Exam

Pay for Exam
(If Applicable)

Thanks for your order

Order #: 485079578

Product Amount

Examity Proctoring Proctoring Service $25.00
Subtotal $25.00
Total $25.00

Paid with Visa XXXX

View Invoice

Lastly, the test-takers will receive an email from notifications@bluesnap.com

confirming their order information.



mailto:notifications@bluesnap.com
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. *Pearson - IT - New_7th sp Vv

*Pearson - IT - New_7th sp — Instructor: Examity Live

Exam Scheduled

ACCUPLACER
You're scheduled to take ACCUPLACER on May 4, 2022 5:00 PM ET

Please arrive 15 minutes prior to the start of your exam to connect with your

proctor and troubleshoot any issues v/ Scheduled May 04 5:00 PM Modily

You can review the exam rules now using the link below or at any time from
s aa;hboard e ? (& Exam Window May 1, 2022 2:34 PM to Jul
you 21,2022 7:59 PM

Schedule Exam

Hide Exam Rules Vv
@ Exam Duration 9 hours

Initial
Confirmation

Standard Rules

v/ Clear your desk and the surrounding area = View Exam Rules

/ Stay connected to a power source

v/ No phones or headphones ’ Conni

v/ No dual monitors

The test-taker will immediately see the pop-up screen with a message that the exam has been
scheduled. In this screen, they can also review a list of their standard rules, any additional rules
or special instructions, and can complete an optional systems check. Once they close out of this
window, their exam dashboard displays the exam card with their appointment.
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ity
' BETTERTEST INTEGRITY.

Dear Lisa Martini,
You have successfully scheduled your ACCUPLACER exam in your *Pearson - IT - New_7th sp.

Your Exam Information

Your Exam Appointment ID 2024615
Sch ed u Ie Exa m Course Name *Pearson - IT - New_7th sp
Exam Name ACCUPLACER
Appointment Date May 04, 2022 5:00PM ET
E ma | | On the day of your exam please remember to:
CO nﬂ rm at| on 1. Login into the Examity site 15 minutes prior to the start of the session.
2. Please have your ID ready to show before you start your exam.
Thank you,
Examity

Contact Support
***DO NOT REPLY TO THIS EMAIL***

The test-taker will also receive an email from donotreply-V5@examity.com
confirming the appointment with reminders for exam day.



mailto:donotreply-V5@examity.com

APPUITILUTICITL
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Reschedule appointment

EXAM DETAILS

[ Exam: Test Exam
Schedule Exam

(10 course: Test Course

Exam Window: Nov 24, 2021 12:00 AM ET —Jan 1, 2031 12:00 AM ET

Mod Ify ¢) Exam Duration: 9 hours
Appointment
(Canceling or

Rescheduling)

Close Cancel Appointment ‘ Reschedule Appointment

The test-taker can change their appointment before exam day by clicking Modify at the
top of the exam card. A pop-up window will appear and prompt the test-taker to either
Cancel Appointment or Reschedule Appointment. If the test-taker reschedules, they
will be prompted to again select another day or time for their new appointment.
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*Pearson - IT - New_7th sp Vv

*Pearson - IT - New_7th sp — Instructor: Examity Live

ACCUPLACER
Connect to Proctor /' Scheduled May 04 5:00 PM
= Exam Window May 1, 2022 2:34 PiM to Jul
. 21,2022 7.59 PM
Prior to
Exam Day ® Exam Duration 9 hours

i= View Exam Rules

The Connect to Proctor button remains grayed out until 15 minutes prior
to the scheduled appointment time.
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*Pearson - IT - New_7th sp Vv

*Pearson - IT - New_7th sp — Instructor: Examity Live

ACCUPLACER

Connect to Proctor /' Scheduled May 04 5:00 PM

=) Exam Window May 1, 2022 2:34 PM to Jul
21,2022 7.59 PM

Exam Day

@ Exam Duration 9 hours

SE View Exam Rules

Connect To Proctor

On exam day, the button turns orange and becomes clickable 15 minutes prior to the
appointment start time. This is when the test-taker can press Connect to Proctor.
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System Check

We're running a quick check to make sure your system meets the requirements to test with Examity.

©)

Q ¢ @

Webcam Microphone Operating System

System Check
i @

Browser Internet Speed

.m ® Chat with an Expert

The test-taker will be prompted to complete the systems check and then select Next.
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Install the Examity Extension

Good luck on your exam! We have a few quick steps to follow on the coming screens, so please take the time to complete each one.

In order to start your exam, you'll need to install the Examity Extension, grant us a few permissions, and verify your identity.

Add Extension

InSta” the Examlty Chrome Extension Help
Extension

Click the button to begin.

Next, the test-taker will need to install the Examity extension by pressing Add Extension.
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Install the Examity
Extension

Add to Chrome

& Examity Proctoring - Chrome Web Store - Google Chrome = m} X

@ chrome.google.com/webstore/detail/examity-proctoring/geapelpefnpekodnnlkcaadniodligebj

&~ chrome web store €& nghorbel@examity.com v

Home > Extensions > Examity Proctoring

Examity Proctoring
Offered by: examity.com

* 56 | Productivity | & 10,000+ users

Overview Privacy practices Reviews Support Related

@ examity”

A pop-up window will appear. The test-taker will need to click on Add to Chrome.
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Install the Examity
Extension

Add Extension

& Examity Proctoring - Chrome Web Store - Google Chrome

# chrome.google.com/webstore/detail/examity-proctoring/geapelpefnpekodnnlikcaadniodligebj

&~ chrome web store

Home > Extensions > Examity Proctol

Examity Proctor

Offered by: examity.com

* v 56 | Productiy

Overview

g examity

Then, the test-taker can click Add Extension to complete the extension setup process.

Ej Add "Examity Proctoring"?

It can:

Read and change all your data on all websites
Display notifications

Read and modify data you copy and paste
Capture content of your screen

Change your settings that control websites' access to features such
as cookies, JavaScript, plugins, geolocation, microphone, camersa, etc.

Privacy practices Reviews Support

v

Q nghorbel@examity.com v

Related

Checking...

Once added, the test-taker will continue to the authentication process.
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Grant Permissions

Allow webcam and
microphone access

i ) ) X  —— Ru  ge
Examity Proctoring wants to

& Use your microphone
@ Use your camera
©CollegeBoara ACCUPLACER

Grant Permissions

We're about to ask for a few system permissions. The
You must grant both permissions to continue.

Exam Permissions Granted Q

Grant Extension Permissions

The test-taker will now be prompted to grant permission to access their webcam and

microphone. They will click “Allow” when prompted.
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©cCollegeBoard ACCUPLACER Exams History Profile System Check Logout

Grant Permissions

We're about to ask for a few system permissions. These are necessary 10 gulde you through the process and keep your exam safe and secure. If permissions are lost at any point, you will be prompted to grant them again
You must grant both permissions to continue.

Exam Permissions Granted o

Grant Permissions

Extension Permissions Granted (&

Click continue

Once permissions have been granted, the test-taker will click “continue” to proceed through
the authentication process.
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Face Verification

If prompted, click "Allow" to tum on your camera, show your face clearty, and click “Take Photo" to capture the image. You can retake the photo if it isn't clear. Once
you're happy with it, click "Use Photo and Continue" to go to the next step.

@ Integrated Camera (5986:2113) v

Authentication

@ Retake Photo

Use Photo And Continue

The first part of the authentication process is the face verification. The test-taker will need to
take a photo — and retake if necessary — and then click Use Photo and Continue.

Face
Verification

- @ Chatwith an Expert




Live Proctoring Exam Overview

ID Verification )

Place your ID clearly in the frame and then click "Take Photo" to capture the image. You can retake the photo if it isn't clear. Once you're happy with it, click "Use Photo
and Continue" to go to the next step.

@ Integrated Camera (5986:2113 v

(. NEW YORK STATE =

DRIVER LICENSE
ID:OOOQ(_)_Q?PQ_CLASS DM

Authentication

SAMPLE,SALLY
1010 ANYPLACE ST
YOURCITY NY 12121
DOB: 07-18-83

SEX:F EYES: BL HT: 5-09
E:NONE

ID Verification

R: NONE
ISSUED: 07-18-05 EXPIRES: 07-18-13 @ Retake Photo

-

Use Photo And Continue
© Chat with an Expert

The second part of the authentication is the ID verification. The test-taker will need to take a
live picture of their ID and then select Use Photo and Continue.
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Your Challenge Question

Answer the question below using the response you gave when creating your account. You'll have three chances to answer correctly. Use our Live Chat feature if you

need help.

What is your mother’s maiden name?

Authentication o

Challenge

Q u eStI O n Copyright © 2021 Examity@‘ All rights reserved. Privacy Policy
Version: 2b6d17b
@ Chat with an Expert

The final step of the authentication process is the challenge questions section. The test-taker
will be asked one of the three challenge questions, enter in the answer, and then click Next.
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Prepare for your Exam

It's important to make sure your space is prepared before the proctor session starts. Please pay attention to any special instructions you may have been given here.

o Review the exam rules and guidelines o Review Special Instructions

« Clear your desk and the surrounding area
« Stay connected to a power source

« No phones or headphones

« No dual monitors

« No leaving your seat

« You must be alone in the room

.
Review . o
Instructions « You must stay in view of the webcam for the duration of the test

« Your webcam, speakers, and microphone must remain on throughout the test

I'm Ready

Copyright © 2021 Exam\ty"’:‘ All rights reserved. Privacy Policy

Version: 2b6d17b
@ Chatwith an Expert

The test-taker will be able to review a list of the Examity standard rules, along with any
additional and special instructions if applicable.
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User Agreement

User Agreement

Take a moment to review these important items.

1. You understand that by using any of the features of the Examity web site and services, you act at your own risk, and you represent and warrant that (a) you are the enrolled student who is authorized to take the applicable exam
and (b) the identification you have provided is completely accurate and you fully understand that any falsification will be a violation of these terms of use and will be reported to the appropriate university or test sanctioning body.

2. You agree that you will be held accountable for any and all infractions associated with identity misrepresentation and agree to participate in the disciplinary process supported by the university or test sanctioning body should any

such party make any request of you

3. You also certify that you are not accepting or utilizing any external help to complete the exam, and are the applicable exam taker who is responsible for any violation of exam rules. You understand and acknowledge that the
applicable university or test sanctioning body will supply all exam rules, and the company will have no responsibility with respect thereto. You agree to participate in the disciplinary process supported by the university or test
sanctioning body should any such party make such request of you in connection with any violation of exam rules.

4. You also acknowledge that your webcam and computer screen may be monitored and viewed, recorded and audited to ensure the integrity of the exams, unless otherwise specified by your university or test sanctioning body. You
agree that no one other than you will appear on your webcam or computer screen. You understand and acknowledge any captured data, along with your test answers, will be stored, retrieved, analyzed and shared with the
university or test sanctioning body, in our discretion, to ensure the integrity of the exams.

| Agree And I'm Ready To Begin The Exa

| do not agree

Copyright © 2021 Examity® Al rights reserved. Privacy Policy

Version: 2b6d17b
@ Chat with an Expert

The test-taker will also need to review the User agreements and then click | Agree And I’'m Ready To
Begin The Exam. If the test-taker chooses I do not agree, then they will NOT be able to take the exam.
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Sharing Your Screen

You're ready to connect with Examity! Click launch and share your screen to begin

A new window will open for this step.

‘ LAUNCH \

Click LAUNCH Select the SCREEN
below to share

Launch

Examity Proctoring is sharing your screen. Stop sharing Hide @ Chatwith an Expert
Cop, . v

ol - y

Screen Launch

Now, the test-taker will be prompted to launch the screen share by clicking Launch.
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Sharing Your Screen

You're ready to connect with Examity! Click launch and share your screen to begin

A new window will open for this s

Screen Launch

Select and Share
Screen

Copyright © 2021 Examity@’ All rights reserved. Privacy Policy

Version: 2b6d17b
© Chat with an Expert

Then, they will need to select their entire screen and click Share.




'

Live Proctoring Exam Overview

O collegeBoard ACCUPLACER Exams  History  Profile  System Check  Logout

Sharing Your Screen

Exam ID: 1768939

You're ready to connect with Examity! Click launch and share your screen to begin

Lastly, the test-taker will choose to Begin Exam.

A new window will open for this step.

Screen Launch

Begin Exam
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You're now ready to take your exam

Screen Mask Your exam will remain covered until your proctor arrives shortly.

Wait for Proctor

T
Examity Proctoring is sharing your screen Stop sharing de

The test-taker is launched to the exam, but they immediately see a screen mask. This
mask will be in place until the proctor arrives to the session.
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Proctor
Connection/Examity
Sidebar

Mask Screen Off/
Sidebar Navigation

Learning Your Sidebar

o) : ; :

Navigation Your Proctor Completed Exam Getting Help

Home

Messages bring Instructions

Help .
Inserting your password

Once your proctor arfives you can insert your

Collapse/Reveal
password using the insert password button
. below and take your exam. If you have
Docker Left/right

questions check the Help tab above.

Scrollable Content

The proctoring tools contain valuable instructions and provide means of support during your

proctoring session. Please take some time to review before you begin.

Examity Proctoring is sharing your screen. Stop sharing Hide

Once the proctor arrives, the test-taker will see themselves, as well as the proctor in the bottom
right-hand corner. The Learning Your Sidebar prompt will appear, and the test-taker can navigate
through this before connecting to a proctor.
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Begin Exam

O 6 @) v I Sl
c
Ci\; Proctoring Instructions

&
What now?

Once you have finished taking your exam and
you are sure you have submitted all required
documents you can end your proctoring
session by clicking the End Proctoring

1. What is example of an integer ?
Session Button.
3.76
418
20 Standard Rules
s C END PROCTORING SESSION

7.01

2. What is the answer to 4+8?

48
5 -
12

Powered by Examity, Inc Exam ID 1768939

The test-taker can now officially begin their exam. The test-taker and proctor remain
screen together for the duration of the exam session.
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% | Proctoring Instructions

What now?

Once you have finished taking your exam and
you are sure you have submitted all required

documents you can end your proctori
1. What is example of an integer ? - "
session by clicking the End Proctoring

3.76

End Proctoring Session?

Are you finished with your Exam?

End Proctoring
Session

2. What is the answer to 4+8?

Once the test-taker completes their exam, they will need to inform the proctor
that they are ready to end the session. Then, they can click End Proctoring Session,
then End Session.
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@ examity’

©CollegeBoard ACCUPLACER

Thank you for using Examity. We'd like to take a moment to ask you a few questions about your experience
through a short survey. We value your opinion and appreciate your feedback

Course Name: Sample Course Exam Name: Sample Exam
1. How smooth was your proctoring experience?
Rough 1 2 3 4 5 6 7 8 9 Very Smooth

2. What is the greatest way for us to improve your proctoring experience?

Survey

Wouldnt change a thing Better trained proctors Make more user friendly Faster connection
.
(O ptl 0 n a I ) 3. How likely are you to suggest Examity to a student who needs proctoring?
Never 1 2 3 4 5 6 7 8 9 Very Likely

Examity®

The exam screen automatically closes after the session ends and the test-taker will now
see a survey. This survey is optional and provides Examity with feedback on the exam experience.




